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I'm assuming basic familiarity with UNIX operating system design, user 
experience with Mac OS X, and some OS X sysadmin-level knowledge

Account management, filesystems, network services, etc.
Where I'm coming from:

UNIX user and some-time admin since 1990
Full-time UNIX admin since 1995
NeXTstep/OS X user and admin since 1991

This presentation primarily covers:
Mac OS X 10.2.6 (Darwin 6.6)
Mac OS X Server 10.2.6 (Darwin 6.6)
Includes some updates for Panther, Mac OS X 10.3 (Darwin 7.0)

Opening Remarks
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This presentation Copyright © 2003 Leon Towns-von Stauber. All rights 
reserved.
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are trademarks of Apple Computer. See http://www.apple.com/
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Apple's customers were used to a secure out-of-the-box experience
Legacy Mac OS offered very few services, and was rarely attacked

As a result, Mac OS X has the most secure default configuration of any 
major UNIX platform

Finally, a UNIX vendor that takes security seriously!
Almost no network services are enabled by default

Exceptions: NTP (UDP 123), Rendezvous multicast DNS (UDP 53, 5353)
Not 5353 in Panther

The root account is disabled (i.e., the password is invalidated)
All superuser access requires authentication as a non-root user first

Out-of-the-Box



X 6

NB: Neither of these points is true for Mac OS X Server
SSH, Server apps, SLP, QTSS can all be listening after a fresh install
root is sometimes necessary (e.g., authenticating in NetInfo Manager 
after enabling Password Server)

Panther: NetInfo Manager can authenticate Password Server users, so 
a valid root password may no longer be needed

Out-of-the-Box
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Introduction
NetInfo
LDAP

Open Directory
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"Open Directory" is a vague umbrella term referring to Apple's 
implementation of various directory services in Mac OS X
I'm using the term to refer to the collection of software based on Open 
Directory domains, accessed by either NetInfo or LDAP, with on-disk data 
formatted as key/value pairs (e.g., NetInfo DB, Berkeley DB)

This is a subset of the full suite of directory software on OS X, which 
includes the Directory Services API, lookupd, DNS (via BIND), WINS (via 
Samba), NIS compatibility, service discovery protocols, etc.

Directory services provide system config data, usually over a network
User accounts, file and printer sharing configuration, host info, etc.

Open Directory            Introduction
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The data in each domain is served from a single master database file
Databases may be cloned to other servers
Domains may have parent/child relationships, creating a hierarchy
Every Mac OS X system hosts a local database, which may be a leaf node 
in a hierarchy
Clients bind to servers using either NetInfo (NeXT legacy protocol) or 
LDAPv3
Lookups go up through hierarchy
Data within database consists of property/value pairs organized in 
filesystem-like directory hierarchy

E.g., my account data is in /users/leonvs, with properties like name, 
passwd, shell, etc.

Open Directory            Introduction
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Contents of Open Directory database, shown in NetInfo Manager

Open Directory            Introduction
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The diagrams on the following two slides illustrate a typical three-tier OD 
hierarchy
hq-master hosts master databases (tagged company and hq) for the / 
and /hq domains
sat-master hosts master DB (tagged satellite) for /satellite 
domain, and cloned DB (tagged company) for / domain
hq-clone hosts cloned DB (tagged hq) for /hq domain
sat-clone hosts cloned DB (tagged satellite) for /satellite 
domain
Each host (except for non-OS X host lower right) hosts own local DB, 
bound into domain hierarchy under /hq or /satellite
hq-client1 and sat-client1 talk to local servers using NetInfo
hq-client2 and sat-client2 talk to local servers using LDAP

Open Directory            Introduction
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Sample three-tier Open Directory domain hierarchy

Open Directory            Introduction
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Sample three-tier Open Directory hierarchy: logical domain structure

Open Directory            Introduction
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Restrict access by network address with trusted_networks property in 
root directory

Takes list of partial dotted-decimal addresses, or names defined in      
/networks

Configure netinfod to run on specified ports with port property in root 
directory

Specify tcp_port and udp_port if you want them to be different
Normally netinfod binds to arbitary ports between 600 and 1023

Clients talk to nibindd to determine netinfod port numbers
Useful for firewalls
nibindd itself still listens on arbitrary ports, known to RPC portmapper
Mac OS X Server can limit access to NetInfo ports, even if dynamic

No more GUI for this in Panther Server

Open Directory            NetInfo
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Limiting NetInfo access in Mac OS X Server Firewall config

Open Directory            NetInfo
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Access to domain data via NetInfo is read-only by default, unless you 
authenticate as the superuser, an administrative user, or a domain admin

Grant write access to properties with _writers_property property
E.g., _writers_passwd: username

Plain _writers property grants write access to all properties in the 
directory
username can be a list, or * (granting access to everyone)

Open Directory            NetInfo
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Shortcomings
No built-in support for secure network communications

Parent/child and master/clone interactions are unauthenticated 
(susceptible to rogue servers) and in the clear (susceptible to 
snoopers)
Use IPsec

All data is readable by any client, including password hashes
Use Password Server, or LDAP ACLs
Panther: By default, password hashes are now shadowed

Open Directory            NetInfo
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OpenLDAP with an Open Directory database backend
Set up access control lists in /etc/openldap/slapd.conf

Especially useful if all clients use LDAP instead of NetInfo
If the DSENGINE_FLAGS_NATIVE_AUTHORIZATION flag is set (which it is 
by default), read access can be restricted, but write access is 
overridden by the usual NetInfo behavior, as described earlier

Increase strength of password hash by replacing CRYPT cipher in 
userPassword attributemap at end of /etc/openldap/schema/
netinfo.schema with SSHA

Use slappasswd -h '{SSHA}' to generate initial password hashes
nicl /domain -create /users/username passwd 'hash' to add

Users change passwords with ldappasswd -x -W -S
Useful if users authenticate only through LDAP

Open Directory            LDAP
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Setting up SSL/TLS on server
1) Self-signed CA cert: openssl req -x509 -new -out ca_cert.pem 
-keyout ca_key.pem -days 3650

2) CSR: openssl req -new -out req.pem -keyout tmp_key.pem
3) Strip passphrase: openssl rsa -in tmp_key.pem -out key.pem
4) Sign: openssl x509 -req -CA ca_cert.pem -CAkey ca_key.pem 
-CAcreateserial -in req.pem -out cert.pem -days 365

5) Configure TLSCACertificateFile, TLSCertificateFile, and 
TLSCertificateKeyFile in /etc/openldap/slapd.conf
6) Start server as slapd -h ldaps:/// in /System/Library/
StartupItems/LDAP/LDAP

7) SystemStarter stop LDAP; SystemStarter start LDAP
8) Optional: Add ldaps entry (port 636) to /etc/services

Open Directory            LDAP
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Setting up SSL/TLS on client
1) Copy /etc/openldap/ca_cert.pem from server to client
2) Configure TLS_CACERT in /etc/openldap/ldap.conf
3) Configure URI as ldaps://server in /etc/openldap/ldap.conf
4) In Directory Access app, enable LDAPv3 and Configure...; enable SSL
5) Also in Directory Access, under Authentication, add the LDAPv3 
directory to a Custom search path
6) Restart Directory Service server: killall DirectoryService

Open Directory            LDAP
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Enabling LDAP over SSL in Directory Access

Open Directory            LDAP
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Introduction
Password Server
Kerberos
Windows/SMB
Network Services

Authentication and Authorization
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Mac OS X supports a variety of authentication methods
Order of use is determined in the Directory Access application
When NetInfo is the source, the key is the authentication_authority 
property in a user's profile
Basic (the default): crypt password hash

As already noted, no shadowing
ApplePasswordServer

LocalWindowsHash

ShadowHash (Panther)
PAM supports authentication based on Directory Services for command-
line and cross-platform UNIX programs

Authentication             Introduction
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Authentication search order in Directory Access

Authentication             Introduction
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Bundled with Mac OS X Server
Based on Cyrus SASL
Supports many auth protocols: CRAM-MD5, APOP, NT, LM, Digest (for 
Apache), etc.
Can set password policies (minimum length, expiration time, etc.)
"Passwords go in, but they don't come out"

Some protocols, such as APOP, compromise this ideal by requiring 
access to decryptable passwords
NeST -getprotocols lists these as Plain (as opposed to Hash)

In a user's profile, no password hash, just a 128-bit ID indexed to an 
entry in Password Server

Server IP identified in OD domain by /config/passwordserver
Usually enabled with Open Directory Assistant; also with NeST

Authentication             Password Server
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User credentials stored in /var/db/authserver/authservermain
Planning issues

Does not support loginwindow on pre-10.2 clients
Enable lower-security protocols like APOP only if necessary
No built-in replication

Yikes!
Make your server as highly available as you can
Consider regular sync of authservermain to warm standby
Consider keeping one or more local admin accounts out of PS
Panther: Can replicate Password Server

Authentication             Password Server
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Sometimes authentication as a PS admin stops working
Corrupted PS DB? May be related to sudden loss of network access.
Following procedure also applies if PS admin password is lost.

1) Login to Password Server system.
2) su -
3) nicl . -create /users/username 
authentication_authority ';Basic;'

4) NeST -NOpasswordserver
5) NeST -hostpasswordserver username password

Authentication             Password Server
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Panther makes much more use of Kerberos, as part of its “Single Sign-
On” features

Following information may only partially apply to Panther
Using Kerberos (v5)

Set up user accounts with Basic authentication
Username must be same as Kerberos principal name

Copy the keytab file from the Kerberos server to /etc/krb5.keytab
Copy edu.mit.Kerberos to /Library/Preferences/, and to ~/
Library/Preferences/ for each user

Sample file at /System/Library/Frameworks/
Kerberos.framework/Resources/

Authentication             Kerberos



X 29

Setting up Kerberos clients
Login Window

Make Kerb auth mandatory by changing value for 
system.login.console in /etc/authorization: replace 
authinternal with krb5auth:authenticate
Make Kerb auth a side effect of logging in by changing value for 
system.login.done: add krb5auth:login
Syntax has changed on Panther; check comments in                          
/etc/authorization for details

Mail application: in Accounts Preferences, select Kerberos 
authentication for SMTP, POP, or IMAP
Automatic for AFP, FTP, TELNET?

Authentication             Kerberos
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Setting up Kerberos services on Mac OS X Server
Apple Mail Server: in Server Settings, under the Mail Service General 
preferences, select either Kerberos (to make it mandatory) or Any (to 
make it optional) authentication

Correspond to kerberos_option_value of 2 or 3, respectively, 
under /config/AppleMailServer in the local OD domain

AFP: in Server Settings, under Apple Access preferences
authentication_mode of kerberos or standard_and_kerberos 
under /config/AppleFileServer in the local domain

FTP: in Server Settings, under FTP Advanced preferences
auth_level of gssapi or both in /Library/FTPServer/
Configuration/ftpaccess

Authentication             Kerberos



X 31

Several options to provide authentication services to Windows clients
Password Server: with NT or LanMan protocols
Local Windows Hash

Method used when you check "Allow user to log in from Windows" 
under user account settings in System Preferences
Unlike Password Server, available in vanilla OS X
Stores password hash in /var/db/samba/hash/username
No longer needed on Panther

Authentication Manager
Method to support Windows in 10.0 and 10.1, before Password Server
Stored encrypted password in user's tim_passwd property

Authentication             Windows/SMB
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Samba offers its own authentication options
Configured in /etc/smb.conf

Authentication schemes: encrypt passwords, security, password 
server, lanman auth, min protocol
Don't use these: null passwords, hosts equiv, use rhosts
Guest access: public, map to guest, guest account, guest only
When acting as PDC: domain admin group, domain guest group
User-based authorization: username map, force user, force 
group, valid users, invalid users, admin users, printer 
admin, read list, write list

Authentication             Windows/SMB
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On Mac OS X, Samba is modified to use Directory Services for 
authentication

Panther: Samba modifications replaced by use of external modules
auth methods directive specifies opendirectory (which makes use 
of /etc/auth/opendirectory.so)
passdb backend directive specifices opendirectorysam

Authentication             Windows/SMB
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Email
Mail application

Kerberos, MD5, APOP options for SMTP, POP, IMAP
Sign (and/or encrypt) messages with GPG (GNU Privacy Guard)

Open implementation of PGP (Pretty Good Privacy)
MacGPG (http://macgpg.sourceforge.net/), GPGMail (http://
www.sente.ch/software/GPGMail/)
How-to:

1) Download and unpack MacGPG quarterly release
2) Install GnuPG and GPGPreferences packages, and GPGKeys 
application
3) Open GnuPG pane in System Preferences to create default 
config files in ~/.gnupg/

Authentication             Network Services
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Email (cont'd.)
Mail application (cont'd.)

GPG (cont'd.)
How-to (cont'd.):

4) Generate key pair, either with GPGKeys or with gpg -gen-key
5) Transform public key to ASCII with GPGKeys->File->Export-
>Key..., and distribute
6) Install GPGMail from MacGPG Contributed Software/ 
folder
7) defaults write com.apple.mail EnableBundles YES
8) Restart Mail to get new PGP preferences, menu items, and 
toolbar icons

Authentication             Network Services
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GPGKeys, GnuPG Preferences, GPGMail

Authentication             Network Services
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Email (cont'd.)
Apple Mail Server

Kerberos, MD5, APOP options for SMTP, POP, IMAP
Sendmail

Web and Multimedia
Apache

Configured in /etc/httpd/httpd.conf
AuthType, Auth*File, AuthName, Require, Satisfy, 
Anonymous_*, AllowOverride, AuthConfig, AccessFileName

mod_auth_apple and mod_digest_apple modules (included with 
Mac OS X Server) allow authentication based on Directory Services

Authentication             Network Services
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Panther Server mail authentication options

Authentication             Network Services
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Web and Multimedia (cont'd.)
QuickTime Streaming Server (QTSS)

Bundled with Mac OS X Server
/Library/QuickTimeStreaming/

Users in qtusers (managed with qtpasswd), groups in qtgroups
qtaccess files in content directories
AuthScheme (basic or digest), AuthName, AuthUserFile, 
AuthGroupFile, Require (user, group, valid-user, any-user)

Streaming Server Admin (web UI) handles authorization internally
Must be in group admin
Sends browser a cookie with qtsspassword, containing Base64-
encoded username:password; uses basic authentication

Authentication             Network Services
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QuickTime Streaming Server admin web interface

Authentication             Network Services
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File Sharing
Apple Filesharing Protocol (AFP)

Kerberos
Guest access maps user to nobody

Must be enabled in both Workgroup Manager and Server Settings 
(or in Open Directory)

Network File System (NFS)
No user-based authentication
root on client usually "squashed" to nobody on server
opts value of maproot=nobody in /exports/share_point in OD

Authentication             Network Services
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File Sharing (cont'd.)
NFS (cont'd.)

NFS resharing (through AFP) provides user-based auth, as well as 
SSH encryption and legacy Mac OS support

AFP server's root must not be squashed on NFS server
1) sudo mkdir -m 0600 /nfs_reshares
2) Create mount points within /nfs_reshares/
3) Mount NFS shares on mount points
4) In Workgroup Manager, create share points from the NFS 
mounts, and set up AFP sharing

Authentication             Network Services
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NFS resharing

Authentication             Network Services
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File Sharing (cont'd.)
File Transfer Protocol (FTP)
lukemftpd (vanilla OS X)
/etc/ftpusers (see Network Access Restrictions section later)

xftpd (OS X Server)
Kerberos
Anonymous ("guest") access
Configured in /Library/FTPServer/Configuration/ftpaccess
anonFTP, auth_level, autogroup, allow-gid, deny-gid, 
allow-uid, deny-uid, loginfails, passwd-check, private, 
upload

ftpusers (see Network Access Restrictions section later)

Authentication             Network Services
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File Sharing (cont'd.)
Web-based Distributed Authoring & Versioning (WebDAV)

Same as Apache
Set up browse (read) and author (write) privileges
Finder on 10.2.4 and later displays warning if WebDAV server uses 
basic authentication (instead of digest)
Basic authentication is default on Mac OS X Server

Can enable digest if users are set up in Password Server
WEBDAV-DIGEST must be among enabled protocols listed with 
NeST -getprotocols

Authentication             Network Services
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WebDAV realm access in Server Settings

Authentication             Network Services
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WebDAV realm access in Panther’s Server Admin

Authentication             Network Services
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File Sharing (cont'd.)
WebDAV (cont'd.)

To enable digest auth:
1) Add to /etc/httpd/httpd.conf:
LoadModule apple_digest_module /usr/libexec/httpd/

mod_digest_apple.so

AddModule mod_digest_apple.c

2) In /etc/httpd/httpd_macosxserver.conf, replace AuthType 
Basic with AuthType Digest
3) Restart web server

Panther: Digest auth enabled by default
And httpd_macosxserver.conf has been rolled up into 
httpd.conf

Authentication             Network Services
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Other open source software
Common UNIX Printing System (CUPS)

Configured in /etc/cups/cupsd.conf
AuthClass, SystemGroup, Require, Satisfy, AuthType, 
RemoteRoot

Berkeley Internet Name Daemon (BIND)
Configured in /etc/named.conf
TSIG to sign transactions between servers
DNSSEC not well supported in BIND 8

Panther includes BIND 9
man -k dnssec for information

Authentication             Network Services
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Other open source software (cont’d.)
OpenSSH
AllowUsers, AllowGroups in /etc/sshd_config
from in authorized_keys

Authentication             Network Services
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Other open source software (cont'd.)
Network Time Protocol (NTP)

Configured in /etc/ntp.conf
How-to:

1) sudo ntp-genkeys -h /etc
2) To /etc/ntp.keys.timestamp, add a human-memorable key
3) Transfer key file to other hosts (using secure transfer method)
4) On each host, ln -s ntp.keys.timestamp /etc/ntp.keys
5) Add keys /etc/ntp.keys to ntp.conf
6) Add trustedkey, controlkey, and requestkey directives
7) Add key argument to server, peer, etc. directives
8) sudo SystemStarter restart "Network Time"

Authentication             Network Services
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Other open source software (cont'd.)
UC-Davis Simple Network Management Protocol (SNMP)

Panther: Updated to Net-SNMP 5 (http://www.net-snmp.org/)
Configured primarily in /usr/share/snmp/snmpd.conf
Community strings
Engine ID
User-based Security Model (USM)

Setting up USM account:
1) sudo killall snmpd
2) Add createUser username SHA password to /var/db/
ucd-snmp/snmpd.conf

3) Restart snmpd

Authentication             Network Services
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Other open source software (cont'd.)
SNMP (cont'd.)

View-based Access Control Model (VACM)
group statements assign USM users to groups
view statements define OID subtrees
access statements define access to views by groups
com2sec statements map community strings to USM security 
names
rocommunity, rwcommunity, rouser, rwuser statements simplify 
configs

Authentication             Network Services
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The root Account
Administrative Accounts
Domain Administrators

Privileged Access
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root logins disabled on Mac OS X, even locally (by an invalid password)
On Mac OS X Server, root password same as initial admin user

Consider changing one or the other, so they're not the same
Enable/disable root logins under NetInfo Manager->Security

Or set a password with sudo passwd root
Panther includes dsenableroot

Allow local root login while denying remote
Add to service file /etc/pam.d/:
auth required pam_securetty.so debug

Create /etc/securetty with console as only entry
SSH: PermitRootLogin in /etc/sshd_config
AFP: allow_root_login OD property in /config/AppleFileServer

Privileged Access         root



X 56

In lieu of logging in as root, Mac OS X encourages the use of 
administrative user accounts

Defined by membership in group admin
The account created during OS install is automatically in admin group

Admin users have several sources of privileged access
Some are configurable, and can be removed from admin group 
members or reassigned to others
Others are hard-coded advantages

Privileged Access         Admin Users
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Directory permissions
/Applications/, /Library/, and /Developer/ are owned and 
writable by admin group, permitting software installations
Permissions can be reset

sudo

Members of admin group given full access in /etc/sudoers, allowing 
execution of CLI utils as superuser (or any other user) by preceding 
command line with sudo
Configuration can be changed

su

Can only su to root if in group admin or wheel
Configurable in /etc/pam.d/su

Privileged Access         Admin Users
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Authorization Services
Component of the Security framework
Admin users can perform authorized actions with superuser privileges
Used by System Preferences, Installer, administrative apps, etc.
Can open files as superuser with /usr/libexec/authopen
Configurable in /etc/authorization

Open Directory
Admin users have full write access to OD domain contents, via either 
NetInfo, or LDAP when NI authorization is enabled

Privileged Access         Admin Users
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AFP (Apple Filesharing Protocol)
Admin users have special abilities determined by OD properties in       
/config/AppleFileServer

admin_gets_sp (Boolean, default 0): Lets admins mount share 
points instead of volumes
attempt_admin_auth (Boolean, default 1): Lets admins use their 
own passwords to authenticate as other users
permissions_model: When set to 
unix_with_classic_admin_permissions, admins can change 
ownership of files
special_admin_privs (Boolean, default 0): Grants admins read 
access to folders regardless of permissions

Can be turned off, but admin group is hard-coded

Privileged Access         Admin Users
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Apple Mail Server
If IMAP Administrator Access in enabled on an alternate port (from 
Server Settings), an admin user can connect to that port with an IMAP 
client and view stored email for all users, as well as queued messages
OD properties in /config/AppleMailServer: admin_port_value, 
enable_admin_port_flag

Can be turned off, but admin group is hard-coded
Not enabled by default

CUPS (Common UNIX Printing System)
Specifying AuthClass System in /etc/cups/cupsd.conf requires 
auth as member of group admin
Configurable with SystemGroup directive
Not enabled by default

Privileged Access         Admin Users
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Samba
Admin users have no extra privileges by default
You could extend admin users' privileges to SMB shares with something 
like this in /etc/smb.conf:
admin users = +admin

QuickTime Streaming Server
Members of group admin can make configuration changes through 
QTSS web interface, but this group is completely defined within           
/Library/QuickTimeStreaming/Config/qtgroups, and is unrelated 
to the system group admin

Privileged Access         Admin Users
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Users can be designated administrators of particular Open Directory 
domains, without being made admin users (i.e., added to admin group)

Panther: Domain admins must be in admin group
Specify which aspects of users, groups, and machines can be managed

Accounts and/or preferences (i.e., things controlled by Workgroup 
Manager)
Can limit to specific users, groups, and machines

Can't specify elements NOT to be managed, which might be nice
Configured in Workgroup Manager

Stored in admin_limits property in user's OD entry

Privileged Access         Domain Admins
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Introduction
Daemons
Authorization Services
Common Data Security Architecture
Keychains

The Security Framework
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Provides infrastructure for security-related functionality to Mac OS X apps
Privileged access, encryption, certificate handling, password storage, 
etc.

Examples
Login Window uses the framework to authenticate graphical logins
Installer and Software Update verify permission to install software
Disk Copy creates encrypted disk images
Apple Mail Server supports SSL connections
Keychain Access is entirely dependent on the Security framework

Security Framework     Introduction
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Security framework and associated components

Security Framework     Introduction
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Every app linked to the Security framework maintains its own instance of 
the framework in its address space

Think of the large box in the preceding diagram as the address space 
of a single process

To put distance between apps and sensitive data, external daemons 
handle most passwords and private keys
The Security Server processes authorization requests, stores keys in 
memory, performs cryptographic computations on keys, evaluates ACLs 
in keychains, and manages keychain master keys
The Security Agent handles user interaction, acquiring user secrets 
(passwords, biometric data, smart card keys, etc.), thus further separating 
such data from the app requesting access
Both daemon executables located in /System/Library/CoreServices/

Security Framework     Daemons
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Authorization Services enables programs (typically GUI apps) to determine 
whether a user should be permitted to take certain actions
An action is associated with an authorization right, configured in a policy 
database

The policy database is an XML file, /etc/authorization
The format of /etc/authorization has changed somewhat on 
Panther

Security Framework     Authorization Services
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Example entry in /etc/authorization, used by System Preferences:

system.preferences: The name of the right
group: Users who authenticate as members of group admin satisfy the 
requirements for this right
shared: Other apps need not reauthenticate within the default timeout
allow-root: No authentication required if logged in as root

Security Framework     Authorization Services

<key>system.preferences</key>
<dict>

<key>group</key>
<string>admin</string>
<key>shared</key>
<true/>
<key>allow-root</key>
<true/>

</dict>
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Default entry (no name) specifies group admin, shared, and a timeout 
of 300 seconds (5 minutes)
Another example, used by loginwindow:

This right is requested by loginwindow after bootup, causing the 
Security Server to start up a Security Agent that displays the login 
dialog
The authinternal value creates a shared credential used by the 
Security Server to authorize a user upon login, negating the need for 
reauthentication by applications after logging in

Security Framework     Authorization Services

<key>system.login.console</key>
<dict>

<key>eval</key>
<string>loginwindow_builtin:login,authinternal, \

loginwindow_builtin:success</string>
</dict>
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Another example, used by PAM:

This right is requested by the pam_securityserver.so module, 
referenced in several service config files in /etc/pam.d/
Thanks to this, successful password-based authentication through a 
PAM-enabled service results in the creation of a shared credential 
within the context of that service (SSH session, etc.)
Possible for remote logins due to push_hints_to_context, which 
forwards auth info to the Security Server, bypassing the Security Agent 
(which normally needs to put up a graphical dialog)

Security Framework     Authorization Services

<key>system.login.tty</key>
<dict>

<key>eval</key>
<string>push_hints_to_context,authinternal</string>

</dict>
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When an application requests authorization for an action (such as starting 
a network service from System Preferences), here's what happens:

1) The application uses the Authorization Services API to contact the 
Security Server, requesting a named right (like system.preferences)
2) The Security Server looks for the right in the policy database (/etc/
authorization), and determines the requirements
3) If the right requires authorization as a member of some group, and 
the Security Server doesn't already possess cached credentials that can 
be shared with the application, it triggers the Security Agent
4) The Security Agent prompts the user logged into the console, then 
attempts to auth the user through the Directory Services framework
5) Directory Service reports success or failure, which is passed back 
through the Security Agent to the Security Server, then back to the 
application

Security Framework     Authorization Services
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The Common Data Security Architecture (CDSA) is a standard originally 
developed by Intel, and now promoted by The Open Group
Apple has implemented it as part of the Mac OS X Security framework
At the base are plug-in modules of various types; Apple's are:

CSP (Cryptographic Service Provider): random number generation, 
encryption/decryption, key generation, hashes, digital signatures
DL (Data Library): file-based storage of certificates, keys, etc.
CSP/DL: manages keychains
X509CL (Certificate Library): manages X.509 certificates in memory
X509TP (Trust Policy): determines validity of X.509 certs

Access to module functionality is through the Common Security Services 
Manager (CSSM) API, the centerpiece of the CDSA

Security Framework     CDSA
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Atop the CSSM, Apple provides higher-level APIs as part of the Security 
framework

Secure Transport: implements SSL/TLS
Offers cleaner integration and abstraction for developers, but 
OpenSSL is more familiar and cross-platform

Certificate, Key, and Trust Services: manages certs and public keys
Keychain Services: programmatic interface to keychains

Security Framework     CDSA
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A keychain is a file containing keys, certificates, passwords, and other 
secured data
Contents are encrypted, protected by an access password
Convenience: a single password unlocks access to a multitude of 
passwords used for web sites, mail servers, file shares, etc.

Makes it practical to use unique, well-chosen passwords for each
A default keychain is created in ~/Library/Keychains/ upon first login

Keychain password same as login password, synced when changing 
login password through GUI
If keychain and login passwords are the same, the keychain is 
automatically unlocked upon login
Panther makes a distinction between default and login keychains

Security Framework     Keychains
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Each key in the keychain has an ACL, managed by the Security Server
Keychain items you see in Keychain Access aren't actually keys

Each item (password, secure note, etc.) is stored in the keychain, and 
encrypted with its own key, which is also stored in the keychain
ACLs are applied to per-item encryption keys, but they're made to look 
as if they're properties of the items the keys protect

A master signing key is used to sign the per-item keys and their ACLs
Per-item keys and the master signing key are themselves encrypted with 
a master key
The master key is encrypted with the keychain password
The master key and master signing key are also stored in the keychain, 
making the keychain file completely portable, requiring only the 
password to unlock its contents

Security Framework     Keychains
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Here's what happens when an app desires access to a keychain item:
1) App makes a request with Keychain Services, through the CSSM, 
which calls on the AppleCSPDL
2) If default keychain is locked, AppleCSPDL retrieves encrypted master 
key and hands it to the Security Server
3) Security Server has Security Agent prompt user for keychain 
password, which is passed back to Security Server
4) Security Server uses password to decrypt master key, then caches it 
in memory (A keychain is unlocked when the Security Server has its 
decrypted master key cached in memory.)
5) Once keychain is unlocked, AppleCSPDL retrieves desired item, 
item's encryption key, and key's ACL, handing them to Security Server

Security Framework     Keychains
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Accessing a keychain item (cont'd):
6) Security Server verifies signature on key and ACL with master signing 
key
7) If signature checks out, Security Server processes ACL, resulting in 
denial, permission, or another prompt through the Security Agent
8) If access is permitted, Security Server decrypts keychain item and 
hands it to AppleCSPDL, which passes it back up the software stack to 
the application

Note that the application process never sees the user's keychain 
password, nor any of the decrypted keys in the keychain

Security Framework     Keychains
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Keychain Access is primary UI for keychain management
In the Settings dialog (under the Edit menu), you can set the keychain to 
lock after some idle timeout, and/or when the machine sleeps

"Locking" means to have the Security Server throw away its cached copy 
of the keychain's decrypted master key
You should consider lowering the idle timeout

Panther includes the security command, which can help manage 
keychains from the CLI
security list-keychains

security lock-keychain keychain

security show-keychain-info keychain

security dump-keychain keychain

See man page for more

Security Framework     Keychains
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Keychain Access

Security Framework     Keychains
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Attributes on Local Filesystems
Attributes on File Shares
Encryption

File Security
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UNIX permissions and ownership
Standard user/group ownership, read/write/execute privileges, as well 
as setuid, setgid, sticky bits
Managed with Get Info in the Finder, or ls -l/chown/chgrp/chmod
Volume permissions

If volume permissions are not enabled on an HFS+ volume (such as 
on removable media volumes), file ownership attributes are ignored

Everything assigned to group unknown, owner as mount point
Turn off/on with Ignore Privileges in Get Info dialog for a volume
Can also use vsdbutil -switch pathname

switch: -c to check, -a to activate, -d to deactivate
/var/db/volinfo.database lists volume status by UUID

File Security                 Local Attributes
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Get Info

File Security                 Local Attributes
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BSD flags
Immutable and append-only flags, as described in man page for 
chflags

HFS Locked attribute mapped to BSD immutable flag
Can view and set in Get Info, or with utils included in Dev Tools
/Developer/Tools/GetFileInfo -al filename

/Developer/Tools/SetFile -a L filename

Same as chflags uchg filename
sappnd and suchg flags are similar to appnd and uchg, but can only be 
unset if the securelevel is 0

This is only the case in single-user mode; securelevel can never be 
lowered, only raised
sysctl kern.securelevel to display current setting

File Security                 Local Attributes



X 84

Apple Filesharing Protocol (AFP)
Often, AFP client maps server file attributes to values that work better 
for the client

Unlike NFS, AFP is designed to work in environments where user and 
group IDs don't match between server and client, and where 
username used for auth may be different than that on client system
On mounted share, file owner set to user ID that mounted share, 
group set to unknown; owner permissions set to whatever is 
appropriate for authenticated user on server, group permissions 
made to match world permissions
Get Info shows actual server attributes, but mapped attributes 
determine access and are shown at command line

Starting with 10.2, if user authenticates with same name used on client, 
and UIDs match, attribute mapping disabled

File Security                 File Share Attributes
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File attribute mapping on AFP shares

File Security                 File Share Attributes
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AFP (cont'd.)
Attributes on files created over AFP are set according to method chosen 
in Workgroup Manager->Sharing->Protocols->Apple File Settings (if 
you're on OS X Server; otherwise, set afp_use_parent_privs property 
under /config/SharePoints/share_point in local OD domain)

"Use standard UNIX behavior": new items owned by authenticated 
user, group matches parent folder; permissions determined by 
default umask of 022, making group collaboration difficult
"Inherit permissions from parent": new with 10.2.3; new files owned 
by authenticated user, new folder owner same as parent folder, 
group matches parent folder; permissions match parent folder, 
which enables collaboration in group-writable folders

File Security                 File Share Attributes



X 87

Server Message Block (SMB)
Samba also does attribute mapping

Attributes usually derived from mount point, but a plethora of 
options in /etc/smb.conf can alter the behavior (some of which can 
be set from Workgroup Manager)
writable, read list, write list, create mask, directory 
mask, force create mode, force directory mode, inherit 
permissions, map archive, map system, map hidden, nt acl 
support

Other file security parameters: delete readonly, dos filemode, dos 
filetimes, follow symlinks, wide links

Network File System (NFS)
No attribute mapping; user and group IDs must match between client 
and server

File Security                 File Share Attributes
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File Transfer Protocol (FTP)
lukemftpd (vanilla OS X)

Configured in /etc/ftpd.conf
umask determines permissions for new files

Default: guest 077, all 027
modify and upload options can disable certain commands

Default: modify guest off

File Security                 File Share Attributes
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FTP (cont'd.)
xftpd (OS X Server)

Based on wu-ftpd
Configured in /Library/FTPServer/Configuration/ftpaccess
defumask determines permissions for new files
Disable access to commands with chmod, delete, overwrite, 
rename, umask

WebDAV
Permissions are wide open, but only authenticated users can access 
WebDAV share mounted in Finder (or directly with mount_webdav)

File Security                 File Share Attributes
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Disk Copy can create password-locked encrypted disk images
Disk Utility on Panther

File Vault (10.3) can encrypt home directories
Many third-party tools

GPGFileTool, PuzzlePalace, etc.

File Security                 Encryption
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ipfw

Graphical Tools

Packet Filtering



X 92

ipfw ported from FreeBSD
Kernel extension (/System/Library/Extensions/IPFirewall.kext) 
and command-line tool (ipfw)
Details in ipfw and ipfirewall man pages

ipfw list displays current list of packet filtering rules
ipfw -N show includes counters, and number->name translation

Packet Filtering            ipfw
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Typical rule set, made by System Preferences with SSH and AFP enabled:

Stateful packet filtering supported with keep-state and check-state
For example, rules 2050 and 2060 above could be replaced with a 
single rule offering better security:
2050 allow tcp from any to any keep-state out

On outbound connection, creates dynamic rule allowing return 
connection only from destination host and port

Packet Filtering            ipfw

02000 allow ip from any to any via lo*
02010 deny ip from 127.0.0.0/8 to any in
02020 deny ip from any to 127.0.0.0/8 in
02030 deny ip from 224.0.0.0/3 to any in
02040 deny tcp from any to 224.0.0.0/3 in
02050 allow tcp from any to any out
02060 allow tcp from any to any established
02070 allow tcp from any to any afpovertcp in
02080 allow tcp from any to any svrloc in
02090 allow tcp from any to any ssh in
12190 deny tcp from any to any
65535 allow ip from any to any
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Related sysctl variables (displayed with sysctl net.inet.ip.fw):

Described in ipfw man page
Setting securelevel to 3 (sysctl -w kern.securelevel=3) 
prohibits rule set changes

Note that securelevel cannot be lowered, so to make rule set 
changes, you'd have to boot into single-user mode

Packet Filtering            ipfw

net.inet.ip.fw.enable: 1
net.inet.ip.fw.one_pass: 1
net.inet.ip.fw.debug: 1
net.inet.ip.fw.verbose: 0
net.inet.ip.fw.verbose_limit: 0
net.inet.ip.fw.dyn_buckets: 256
net.inet.ip.fw.curr_dyn_buckets: 256
net.inet.ip.fw.dyn_count: 0
net.inet.ip.fw.dyn_max: 1000
net.inet.ip.fw.dyn_ack_lifetime: 300
net.inet.ip.fw.dyn_syn_lifetime: 20
net.inet.ip.fw.dyn_fin_lifetime: 20
net.inet.ip.fw.dyn_rst_lifetime: 5
net.inet.ip.fw.dyn_short_lifetime: 30
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System Preferences->Sharing->Firewall
One-button activation
Automatically opens ports as services are enabled
Filters stored in /Library/Preferences/
com.apple.sharing.firewall.plist, activated by 
NetworkExtensions startup item

Server Settings->Network->Firewall
Mac OS X Server
Clunkier, but more flexible, interface
Server Status displays results of ipfw show
Configuration in /config/IPFilters in local Open Directory domain
Panther: Use Server Admin; config stored in files in /etc/ipfilter/

Packet Filtering            Graphical Tools
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Mac OS X Sharing Preferences

Packet Filtering            Graphical Tools
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Mac OS X Server: Server Settings and Server Status

Packet Filtering            Graphical Tools
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Panther Server: Server Admin

Packet Filtering            Graphical Tools
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Third-party ipfw front ends
sunShield (http://homepage.mac.com/opalliere/shield_us.html)

Freeware
System Preferences pane, startup item
Little more control, nice features and interface, but important 
limitations (no dynamic rules, logging, etc.)

Impasse (http://glu.com/products/impasse/)
Commercial, with trial period
System Preferences pane, startup item, daemon
Nearly full control, straightforward interface, especially nice log 
viewer

Packet Filtering            Graphical Tools
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sunShield

Packet Filtering            Graphical Tools
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Impasse

Packet Filtering            Graphical Tools
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Third-party ipfw front ends (cont'd.)
BrickHouse (http://personalpages.tds.net/~brian_hill/
brickhouse.html)

Shareware
Application, startup item
Lots of configurability

Third-party firewall software not based on ipfw
Firewalk X (http://www.pliris-soft.com/products/firewalkx/)
NetBarrier (http://www.intego.com/netbarrier/)
Norton Personal Firewall (http://www.symantec.com/sabu/nis/
npf_mac/)
IPNetSentryX (http://www.sustworks.com/site/
prod_sentryx_overview.html)

Packet Filtering            Graphical Tools



X 103

BrickHouse

Packet Filtering            Graphical Tools
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MAC Address Restrictions
General Access Restrictions
Apple Mail Server
File Sharing
Other Open Source Products

Network Access Restrictions
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Mac OS X Server DHCP server
Prevent obtaining IP addresses from DHCP by listing allowed MACs 
under Filter preferences for DHCP/NetBoot in Server Settings

Panther: Under NetBoot in Server Admin (now separate from DHCP)
Not sure whether these restrictions apply only to NetBoot clients 
or to DHCP generally

Configuration stored in OD under /config/dhcp
AirPort Base Station

Limit all wireless access to select list of MAC addresses under Access 
Control in AirPort Admin Utility

NB: Nowadays, MAC addresses are easily reset with commonly available 
software

Network Access           MAC Addresses
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TCP Wrapper offers general access restrictions
Configured in /etc/hosts.allow and /etc/hosts.deny
Mac OS X software built with TCP Wrapper support includes OpenSSH, 
UCD SNMP, and xinetd

xinetd is more secure alternative to inetd
Configured in /etc/xinetd.conf and service files in /etc/xinetd.d/
only_from, no_access, access_times

IP-based ACLs supplemented by TCP Wrapper, unless flags = 
NOLIBWRAP specified

Network Access           General
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Apple Mail Server (AMS) is derived from AppleShare IP (network software 
for the legacy Mac OS), and is bundled with Mac OS X Server
Configured from Server Settings

Config stored in /config/AppleMailServer in local OD domain
SMTP relay restrictions

Under Incoming Mail preferences, "Allow SMTP relay for: only hosts in 
this list:" prevents use as open relay

By default, lists only IP addresses associated with server's loopback 
and Ethernet interfaces

Under Filter preferences, can reject mail from servers listed explicitly, 
on a blackhole list, or with mismatched hostname/IP
Panther: Server software has changed (from AMS to Postfix), but GUI 
options are similar

Network Access           Apple Mail Server
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Panther Server SMTP relay restrictions

Network Access           Apple Mail Server
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Samba
Configured in /etc/smb.conf
hosts allow, hosts deny

NFS
Restrict access to specified hosts or network addresses on Mac OS X 
Server with Workgroup Manager, under NFS Export Settings

Configuration stored in clients property under /exports/
share_point in local OD database

Network Access           File Sharing
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FTP
lukemftpd (vanilla OS X)

Configured in /etc/ftpusers
user_pat[:group_pat][@src_pat] [directive [class]]

*_pat: ? for single-character, * for multi-char replacement
directive defaults to deny
If no rule matches, access permitted

Examples
*:ftpusers allow

Anyone in ftpusers group allowed
*@192.168.1.0/24 allow

Anyone from local network allowed

Network Access           File Sharing
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FTP (cont'd.)
lukemftpd (cont'd.)

Test access rules with:
ftpd -C username; echo $?

Prints 0 if username would be allowed, 1 if not
xftpd (OS X Server)

Based on wu-ftpd
Configured in /Library/FTPServer/Configuration/ftphosts
{ allow | deny } username source [source...]

source is hostname, IP address, or subnet address

Network Access           File Sharing
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FTP (cont'd.)
xftpd (cont'd.)

Configured in /Library/FTPServer/Configuration/ftpaccess
deny source file

If client address maches source, display contents of file and 
deny access

dns refuse_no_reverse file, dns refuse_mismatch file
Reject clients with mismatched or no reverse lookup, after 
displaying contents of file

Network Access           File Sharing
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Apache
Configured in /etc/httpd/httpd.conf
Allow from, Deny from, Order, HostnameLookups Double, 
Satisfy, Options, AllowOverride, AccessFileName
Also, /etc/servermgrd/servermgrd.conf on Mac OS X Server, for 
the Server Manager Daemon (an instance of Apache)

Common UNIX Printing System (CUPS)
Configured in /etc/cups/cupsd.conf
Allow from, Deny from, Order, BrowseAllow from, BrowseDeny 
from, BrowseOrder, HostnameLookups Double, Satisfy

Network Access           Open Source



X 114

BIND
Configured in /etc/named.conf
acl statements, allow-* and blackhole options

NTP
Configured in /etc/ntp.conf
restrict source_address [mask netmask] [flag]...

Flags include ignore, noserve, noquery
View with ntpdc -c reslist hostname

Network Access           Open Source
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SSH
SSL/TLS
IPsec
PPTP
WEP

Encrypting Network Transmissions
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Secure Shell
OpenSSH ships with Mac OS X
Enable from System Preferences, under Sharing, as "Remote Login"
AFP encryption runs over an SSH tunnel
SSH Helper (http://www.gideonsoftworks.com/sshhelper.html)

Freeware
Manages sshd_config, authorized_keys, etc.

Network Encryption     SSH
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SSH Helper

Network Encryption     SSH
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Secure Sockets Layer/Transport Layer Security
Many services can be set up to use SSL (most based on OpenSSL)

OpenLDAP
Apache, WebDAV (Finder as client doesn't work with SSL)
CUPS (but it breaks printing if you're not careful, and even if you are, 
the CUPS SSL implementation appears to be very unstable)
Samba (but you'll have to compile your own)

Panther: Samba is compiled with SSL support
Sendmail, Postfix, Cyrus IMAP
Server Manager Daemon
QuickTime Streaming Server admin web interface
Apple Mail Server IMAP (based on CDSA, not OpenSSL)

Network Encryption     SSL/TLS
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IP Security
Based on KAME, same as used on other BSD platforms
Provides authentication and encryption at a low layer of the TCP/IP stack, 
so it's transparent to applications

Unlike SSL, services don't need to be set up individually, or even know 
it's going on

No built-in GUI
Panther has GUI (client in Internet Connect, server in Server Admin)
Managed with setkey, racoon, and racoonctl, and some sysctl 
variables: net.inet.ipsec.*, net.inet6.ipsec6.*, net.key.*

Third-party GUIs
VPN Tracker (http://www.equinux.com/us/products/vpntracker/)
VaporSec (http://www.afp548.com/Software/VaporSec/), free

Network Encryption     IPsec
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Panther Server Admin VPN settings

Network Encryption     IPsec
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VPN Tracker

Network Encryption     IPsec
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VaporSec

Network Encryption     IPsec
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Point-to-Point Tunneling Protocol
Primarily used for personal VPNs by Windows clients
Configured in Internet Connect application
On Mac OS X Server, vpnd provides a PPTP front end to the PPP daemon

Details in man page

Network Encryption     PPTP
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Setting up PPTP in Internet Connect

Network Encryption     PPTP
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Setting up PPTP in Panther’s Internet Connect

Network Encryption     PPTP
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Wired Equivalent Privacy
Used to protect Wi-Fi (802.11) connections

AirPort is Apple's brand name for 802.11
Minimal encryption; soon to be supplanted by stronger crypto algorithms
Use a strong 128-bit password, and create a closed network
Consider IPsec for additional security

Network Encryption     WEP
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AirPort Base Station settings

Network Encryption     WEP



X 128

Locking User Access
Open Firmware
Password Shadowing
Setting Password Requirements

Password Protection



X 129

Set screen lock under System Preferences->Screen Effects->Activation
Panther: System Preferences->Security->”Require password to wake 
this computer from sleep or screen saver”
Logged-in user's name and password, or admin user's name and 
password, unlocks screen saver

Lock Terminal or console sessions with lock (see man page)
E.g., lock -p -t 10000000

Password Protection    Locking User Access
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Setting Open Firmware password disables key sequences that allow 
booting from an alternate device

Open Firmware Password application at http://www.apple.com/
downloads/macosx/apple/openfirmwarepassword.html

Sets security-password OF variable, and sets security-mode to 
command

Can do the same with nvram CLI tool
Setting security-mode to full prevents booting without someone 
available to enter the password

Password Protection    Open Firmware



X 131

It doesn't work, so don't bother trying
Access to authentication data mediated by root-owned processes 
(primarily lookupd and DirectoryService), so everyone can access it

The best you can do is set up shadowing, and make the workarounds 
non-obvious (i.e., "security through obscurity")

Besides, it involves keeping auth data in flat files, which means you lose 
the convenience of using a directory service
Use Password Server
Panther shadows passwords by default!
ShadowHash authentication_authority
Hash is encrypted, and stored in /var/db/shadow/hash/, readable 
only by root

Password Protection    Password Shadowing
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By default, /usr/bin/passwd requires at least 5 characters in password
Set security_options Open Directory property to increase that to 8 
characters, with at least 1 non-alpha
sudo nicl domain -create security_options 

secure_passwords

Only affects passwd CLI tool
Password Server lets you set minimum length (in Workgroup Manager, 
under Advanced->Options... when a user account is selected)
Panther Server includes new options

Password Protection    Password Requirements
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Password Server options

Password Protection    Password Requirements
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Panther Server password options

Password Protection    Password Requirements
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Login Options
Rendezvous
Process Accounting
Virus Protection
STOS and SE-Darwin

Miscellany
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Bad ideas for security in System Preferences->Accounts
Under Users, Set Auto Login... triggers automatic login after bootup, to 
emulate a single-user personal computer

Username saved as value of autoLoginUser in /Library/
Preferences/com.apple.loginwindow.plist

Encrypted password apparently saved in /etc/kcpassword
Under Login Options, can choose to have list of system accounts 
displayed at login (instead of simple username/password dialog)
Can display a password hint after series of unsuccessful login attempts

Consider cron job to wipe out hint and _writers_hint properties 
from user account entries in Open Directory

Miscellany                    Login Options
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Rendezvous is Apple's implementation of Zeroconf (http://
www.zeroconf.org/)
Automatic link-local addressing

Allows any device to acquire valid IP
Not a big deal, though: open DHCP does the same, and it's easy to find 
a valid IP once you have physical access to the network anyway

Miscellany                    Rendezvous
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Multicast DNS (mDNS), DNS Service Discovery (DNS-SD)
Rogue responder easier to set up than with regular DNS (no need to 
hijack a DNS server's IP address), could serve bogus and misleading 
data (e.g., mail)
mDNSResponder may have undiscovered bugs; unlikely, due to open 
source and compactness
Disabling

Client: Remove or rename /etc/resolver/
Server: Remove or rename mDNSResponder startup item or 
executable
Watch out for OS updates

Miscellany                    Rendezvous



X 139

Process accounting functional as of 10.2
Enable with:
mkdir /var/account

touch /var/account/acct

chmod 0600 /var/account/acct

accton /var/account/acct

Every process logged to /var/account/acct, viewable with lastcomm
Accounting log supposed to be rotated by /etc/periodic/daily/
500.daily cron job, but the sa command doesn't exist on Mac OS X

Replace sa line with cat /dev/null > acct

Miscellany                    Process Accounting
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No Mac OS X-specific malware to date
Still, a possibility for the future
And Mac OS X can act as a carrier

Commercial anti-virus products
Norton AntiVirus (http://www.symantec.com/nav/nav_mac/)
VirusBarrier (http://www.intego.com/virusbarrier/)
Anti-Virus (http://www.sophos.com/products/software/
antivirus/savmac.html)

Miscellany                    Virus Protection
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The Secure Trusted Operating System (STOS) Consortium (http://
www.stosdarwin.org/) brings together representatives from the U.S. 
federal government, academia, and private industry to work on advanced 
security capabilities using the Darwin kernel as a starting point
SE-Darwin meant to conform to Common Criteria

Similar to other government-sponsored programs working with open-
source OSes, such as Security-enhanced Linux

Also working on other projects:
Apache SSL module using CDSA instead of OpenSSL
PGP implementation using CDSA
OpenSSH on CDSA
Honeypots on Darwin

Miscellany                    STOS and SE-Darwin
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Web Sites
Mailing Lists
Books

Resources
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Apple's Mac OS X site
http://www.apple.com/macosx/

Apple's Security Updates page
http://www.apple.com/support/security/security_updates.html

MacSecurity.org
http://www.macsecurity.org/

SANS Reading Room: Apple Issues
http://rr.sans.org/mac/mac_list.php

Mac OS X Hints
http://www.macosxhints.com/

Occam's Razor Apple/NeXT page
http://www.occam.com/links/apple.html

Resources                    Web Sites
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security-announce (Apple)
http://lists.apple.com/mailman/listinfo/security-announce/

MacSec (MacSecurity.org)
http://www.macsecurity.org/mailman/listinfo/macsec/

MacOSX-admin (Omni Group)
http://www.omnigroup.com/developer/mailinglists/macosx-

admin/

macos-x-server (Apple)
http://lists.apple.com/mailman/listinfo/macos-x-server/

Resources                    Mailing Lists
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Practical Unix & Internet Security
Simson Garfinkel, Gene Spafford, Alan Schwartz

Mac OS X in a Nutshell
Jason McIntosh, Chuck Toporek, Chris Stone

Resources                    Books
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This talk has focused on security issues, both risks and opportunities, 
mostly specific to Mac OS X

But remember that Mac OS X is UNIX, and similar considerations apply 
as to any other UNIX platform

Evaluation forms
Some considerations

Level of detail, pacing, slides
Content (things you'd have liked to see, or liked to see gone)
Compatibility with SA tutorial (if you took that)

BoF: Tuesday 9 PM
Slides available at http://www.occam.com/osx/
Q & A

Closing Remarks


